
3.2.3.3 China Postage 
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□ Enable  
 

Enable China Postage 
Disable China Postage 

□ Length  
 

 

Min Length can be set from 2 to 80 
Max Length can be set from 2 to 80 

□ Fixed Length  
 
 

 

Fixed Length 1 2-80 
Fixed Length 2 2-80 
Fixed Length 3 2-80 
 

□ Check Digit  
 

Check Digit transmit 
Check Digit doesn’t transmit 

Verify 
□ Checksum 

 
 

Enabled 
Disabled 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.4 Code93 
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□ Enable  
 

Enable Code93 
Disable Code93 

□ Concatenation  
 

Enable Concatenation 
Disable Concatenation 

Default  Tap the “Default” tab to return back to 
default setting 

Code93 is a variable length, continuous 
symbology that uses four element 
widths. 



3.2.3.5 Matrix 2 of 5 
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□ Enable  
 

Enable Matrix 2 of 5 
Disable Matrix 2 of 5 

□ Length  
 

 

Min Length can be set from 2 to 80 
Max Length can be set from 2 to 80 

□ Fixed Length  
 
 

 

Fixed Length 1 2-80 
Fixed Length 2 2-80 
Fixed Length 3 2-80 
 

□ Check Digit  
 

Check Digit transmit 
Check Digit doesn’t transmit 

Verify 
□ Checksum 

 
 

Enabled 
Disabled 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.6 IATA 
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□ Enable  
 

Enable IATA 
Disable IATA 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.7 Code128 
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□ Enable  
 

Enable Code128 
Disable Code128 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.7 Code11 
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□ Enable  
 

Enable Code11 
Disable Code11 

□ Check Digit   
 
 

 

Check Digit Transmit 
Check digit verification can select “ 1 
Digit” or “2 Digits” 
Check Digit doesn’t transmit 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.8 MSI/PLESSEY 
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□ Enable  
 

Enable MSI/PLESSEY 
Disable MSI/PLESSEY 

□ Check Digit   
 
 

 

Check Digit transmit 
Check digit verification can select “ 1 
Digit” or “2 Digits” 
Check Digit doesn’t transmit 

Check Mode  One of “Mode10”, “Mode10-10” and 
“Mode11-10” can be selected from the 
pull-down list. 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.9 UPC-A 
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□ Enable  
 

Enable UPC-A 
Disable UPC-A 

Format  Only one of the “Without Truncation”, 
“Truncate Leading Zero”, “Truncate 
Leading Digit” and “Truncate Leading 
Zero and Digit” can be selected from the 
pull-down list. 

Check Digit  
 

Check Digit transmit 
Check Digit doesn’t transmit 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.10 EAN-13 
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□ Enable  
 

Enable EAN-13 
Disable EAN-13 

Format  Only one of the “Without Truncation”, 
“Truncate Leading Zero”, “Truncate 
Leading Digit” and “Truncate Leading 
Zero and Digit” can be selected from the 
pull-down list. 

Check Digit  
 

Check Digit transmit 
Check Digit doesn’t transmit 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.11 UPC-E/UCC EAN-128 
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□ Enable  
 

Enable UPC-E/UCC EAN-128 
Disable UPC-E/UCC EAN-128 

Format  Only one of the “Without Truncation” 
and “Truncate Leading Zero” can be 
selected from the pull-down list. 

Check Digit  
 

Check Digit transmit 
Check Digit doesn’t transmit 

Enable UCC EAN-128  
 

Enable UCC EAN-128 
Disable UCC EAN-128 

Enable UPC-E 
Convert to UPC-A 

 
 

Enable UPC-E Convert to UPC-A  
Disable UPC-E Convert to UPC-A 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.12 Interleaved 2 of 5 
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□ Enable  
 

Enable Interleaved 2 of 5 
Disable Interleaved 2 of 5 

□ Length  
 

 

Min Length can be set from 2 to 96 
Max Length can be set from 2 to 96 

□ Fixed Length  
 
 

 

Fixed Length 1 2-96 
Fixed Length 2 2-96 
Fixed Length 3 2-96 
 

□ Check Digit  
 

Check Digit transmit 
Check Digit doesn’t transmit 

Verify 
□ Checksum 

 
 

Enabled 
Disabled 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.13 Codabar/NW7 
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□ Enable  
 

Enable Codabar/NW7 
Disable Codabar/NW7 

□ Start/Stop  
 

Start/Stop transmit 
Start/Stop doesn’t transmit 
????? 

□ Checksum  
 

Checksum transmit 
Checksum doesn’t transmit 

Verify 
□ Checksum 

 
 

Enabled 
Disabled 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.14 EAN-8/JAN-8 
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□ Enable  
 

Enable EAN-8/JAN-8 
Disable EAN-8/JAN-8 

Format  Only one format of “Without 
Truncation” and “Truncate Leading 
Zero” can be selected from the pull-down 
list. 

□ Check Digit  
 

Check Digit transmit 
Check Digit doesn’t transmit 

Verify 
□ Checksum 

 
 

Enabled 
Disabled 

□ Enable EAN-8 
Convert to EAN-13 

 
 

Enable EAN-8 Convert to EAN-13 
Disable EAN-8 Convert to EAN-13 

Transmit 5 zeros  One kind of “Before BarCode” and 
“After 3 Digits” is selected from the 
pull-down list. 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.15 Code4 
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□ Enable  
 

Enable Code4 
Disable Code4 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.16 ISBN 
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□ Enable  
 

Enable ISBN 
Disable ISBN 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.17 Korea Code 3 of 5 
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□ Enable  
 

Enable Korea Code 3 of 5 
Disable Korea Code 3 of 5 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.18 GTIN 
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□ Enable  
 

Enable GTIN 
Disable GTIN 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.3.19 UOC-EAN Add on 2/5 
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□ Enable  
 

Enable UPC-EAN Add on 2/5 
Disable UPC-EAN Add on 2/5 

Default  Tap the “Default” tab to return back to 
default setting 



3.2.4 Brightness 
 
Table 3-3 Brightness 
  ICON  ITEM & FUNCTION 

z “Brightness Control” Applet ( Figure 3-4-1) :  

9 Control the LCD brightness and KEYPAD Brightness 

9 Tap the “LCD brightness” Tab, and then tune the LCD 
brightness by tapping right-arrow & left-arrow. Can also tune 
the LCD brightness by pressing right-direction key or 
left-direction key. 

9 Tap the “KEYPAD Brightness” Tab, and then tune the Keypad 
brightness by tapping right-arrow & left-arrow. Can also tune 
the Keypad brightness by pressing right-direction key or 
left-direction key. 

z “Backlight Timeout” Applet( Figure 3-4-2~  Figure 3-4-5): 

9 Select one power source from the pull-down list, “ AC power” & 
“Battery” of Power Scheme. 

9 Select the timeout duration from another pull-down list of “Turn off 
backlight after” Tab. 
< Never, 15 seconds, 30 seconds, 1 minutes, 2 minutes, 5 minutes> 

9 The Backlight will be turned off after the selected timeout value 

9 □ Dim backlight after 20 seconds of idleness 

ITEM              Function 

 The brightness of backlight keep the same brightness even 
though system is already idle. 

 
Brightness 

 The brightness of backlight will change to a little dark during 
system idle situation after 20 seconds when the system isn’t 
running any action. 
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      Figure 3-4-1                       Figure 3-4-2 
 

 
       Figure 3-4-3                     Figure 3-4-4 
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 Figure 3-4-5 
 
 
3.2.5 Certificates 
 
Certificates are used by some applications for establishing trust and for secure 

communications.  
 Certificates are signed and issued by certificate authorities and are valid for a 
prescribed period of time. Windows CE manages multiple certificate stores. 
Table 3-4 Certificates(A) 
  ICON  ITEM & FUNCTION 

z “Store” Tab ( Figure 3-5-1) :   
Certificates 9 In the Stores tab, select the certificate store you wish to view or 

modify from the drop-down list (Figure 3-5-2).  

9 The “Trusted Authorities “store lists the top-level certificates 
for authorities you trust.( Figure 3-5-2 , Figure 3-5-3)  

9 The “My Certificates “store contains your personal certificates, 
which you use to identify yourself.  

9 Intermediate certificate authorities that help establish a chain of 
trust are stored in the “Other Authorities” store. 
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Table 3-4 Certificates(B)  
  ICON  ITEM & FUNCTION 

z “Store” Tab :   
Certificates 9 To add a certificate or associated private key to the selected 

store, select “Import” (Figure 3-5-4). 
9 To view more details of the selected certificate, such as the 

expanded name or expiration date, choose “View”. 
9 To delete the selected certificate from the store, choose 

“Remove”. 

 
 

 

 
   Figure 3-5-1                     Figure 3-5-2 
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      Figure 3-5-3                      Figure 3-5-4 
 

 
 Figure 3-5-5 
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3.2.6 CPU Speed 
 
Table 3-5 CPU Speed  
  ICON  ITEM & FUNCTION 

z “CPU Speed” Tab :( Figure 3-6)   
CPU Speed 9 Provide the information of current CPU Speed. 

9 To change the CPU Speed , select the desired CPU speed you 
want. 
< 100 MHz, 200MHz, 300MHz, 400MHz >  

 

 
Figure 3-6 
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3.2.7 Date/Time 
 
Table 3-6 Date/Time 
  ICON  ITEM & FUNCTION 

z “Date/Time” Tab :( Figure 3-6)   
Date/Time 9 Please see the detail information of 2.5.1 Setting Time and 

Date on P2-22  

 
 
3.2.8 Dialing Properties 
 
Table 3-7 Dialing properties(A) 
  ICON  ITEM & FUNCTION 

z “Dialing Properties” Tab :( Figure 3-7-1)  

9 In the When dialing from list, select the “Location” where you 
want to change settings.(Figure 3-7-2) 

9 To create a new location, select “New”. Enter the name of the 
location, and then select “OK”.(Figure 3-7-3) 

9 Enter or edit the area code and local country code as needed. 
9 In Dial using, select “Tone dialing” or “Pulse dialing”. Most 

phone lines are tone. 
9 To automatically disable call waiting, select “□ Disable call 

waiting by dialing＂, select the appropriate number sequence in the 

list, or enter a new sequence. 

 
Dialing 
Properties 

z Editing dialing patterns (Figure 3-7-4) 

9 Using the codes listed in the topic, revise the dialing patterns as 
needed. 

Notes: 
� If you need to use character other than the ones listed here, 

use manual dialing. 
� Hyphens and spaces in dialing strings are ignored. 
� Some modems may not respond to the following characters, 

even though your device lets you add them to the dial 
string. 
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       Figure 3-7-1                      Figure 3-7-2 
 

    
 Figure 3-7-3                        Figure 3-7-4 
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3.2.9 Display Properties 
 
Table 3-8 Display properties(A) 
  ICON  ITEM & FUNCTION 

z “Background” Tab :( Figure 3-8-1)  

9 From the “Image” list, select an image you want as the 
background of the desktop.(Figure 3-8-2) 

9 To locate an image in another folder, select “Browse”.(Figure 
3-8-3) 

9 To have the image cover the entire background, select “ □Tile 
image on background” 

z “Appearance” Tab(Figure 3-8-4) 

 
Display 

9 Change the color scheme :( Figure 3-8-5) 

¾ From the” Scheme” list, select a scheme. 
¾ View your choice in the preview box. If you like the 

scheme, select “Apply”. 
9 Create a custom color scheme: 

¾ From the “Item” list, select a display item. 
¾ From the “Basic colors” list, select a color, and select 

“OK”. 
¾ View your color selection(s) in the Preview box. 
¾ To save the scheme, select “Save”. 
¾ In the “Save this color scheme as” box, enter a name 

for the scheme, and select “OK”. 
¾ Select “Apply”. 
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       Figure 3-8-1                       Figure 3-8-2 
 

   
         Figure 3-8-3                      Figure 3-8-4 
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      Figure 3-8-5 

 
3.2.10 Fkey Settings 
 
Table 3-9 FKey (A) 
  ICON  ITEM & FUNCTION 

z “Hot keys” Tab :( Figure 3-9-1)  

9 Assign your hot keys to wakeup system after it goes into sleep 
mode. 

9 To select which key(s) that can wakeup system, then, tap “OK”. 
< F1 key, F2 key, F3 key, F4 key and Scanner Buttons> 

  

z “AP Settings” Tab(Figure 3-9-2) 

 
FKey 
Setting 
 

9 To assign your favorite application program to F1,F2,F3 and F4 hot 
keys. 

9 Choose one of F1, F2, F3 and F4 from pull-down list.(Figure 
3-9-3) 

9 To tap “ Open” inside “Assign program” applet.  

9 Select one application program you want from program list, Then, 
choose “OK”. (Figure 3-9-4) 

9 To tap Default tab to return back to default setting. (Figure 3-9-2) 

 
P3-37 



Table 3-9 FKey (B) 
  ICON  ITEM & FUNCTION 

z “AP Settings” Tab(Figure 3-9-2) 

9 The default setting for F1~F4: 

 

F Key   Name of Application Program 
F1 Internet Explorer  
F2 WordPad 
F3 Inbox 
F4 My Computer 

 
FKey 
Setting 
 

 

 
 

   
     Figure 3-9-1                        Figure 3-9-2 
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         Figure 3-9-3                           Figure 3-9-4 
  
3.2.11 Information 
 
Table 3-10 Information 
  ICON  ITEM & FUNCTION 

z “Information” Tab :  

 
Information 

9 Provide hardware version, Software version, ROM size, RAM 
size, Serial No. and Configuration No. 

 
3.2.12 Input Panel 
 
Table 3-11 Display properties(A) 
  ICON  ITEM & FUNCTION 

z “Input panel” Tab :( Figure 3-10-1)   
Input Panel 9 Select the input method you want to change. 

9 To change the Soft Keyboard Options , tap “Option” (Figure 
3-10-2) 

. 
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Table 3-11 Display properties(B) 
  ICON  ITEM & FUNCTION 

z “Input panel” Tab :   
Input Panel 9 Change the soft keyboard options as desired, selecting from: 

¾ Large or small keys 

¾ Using gestures for space, black-space shift, and enter. 
9 To exit the soft keyboard Options, press “OK” on the control 

bar, or press the <Enter> key on the keypad. 
9 To exit the Input Panel, press “OK” on the control bar, or press 

the <Enter> key on the keypad. 
. 

 

   
 Figure 3-10-1                       Figure 3-10-2 

3.2.13 Internet Options 
 
Table 3-12 Internet Options(A) 
  ICON  ITEM & FUNCTION 

z “General” Tab :( Figure 3-11-1)   
Internet 
Settings 

9 Type in the URL of desired start page and the desired search 
engine. You also change the Cache Size, clear the Cache and 
Clear the History.. 
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Table 3-12 Internet Options(B) 
  ICON  ITEM & FUNCTION 

z “Connection” Tab :( Figure 3-11-2)  

9 Modify the network access setting as desired. 
z “Security” Tab (Figure 3-11-3) 
9 Modify the security settings as desired. You can enable any of 

the following by tapping the checkbox: 

¾ Allow cookies 

¾ Allow TLS 1.0 security 

¾ Allow SSL 2.0 security 

¾ Allow SSL 3.0 security 

¾ Warm when switching across secure and insecure areas. 
z “Advanced” Tab (Figure 3-11-4) 

Internet 
Settings 

9 Modify the security settings as desired. You can enable any of 
the following by tapping the checkbox: 

¾ Display Image in pages 

¾ Play sounds in pages 

¾ Enable scripting 

¾ Display a notification about every script error 

¾ Underline links- 

○ Never 

○ Always 
○ Hover 
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    Figure 3-11-1                          Figure 3-11-2 
 

   
 Figure 3-11-3                   Figure 3-11-4 
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3.2.14 Keyboard 
 
Table 3-13 Keyboard(A) 
  ICON  ITEM & FUNCTION 

z “Repeat” Tab :( Figure 3-12)   
Keyboard 9 To change the amount of time between depressions before 

repetition starts, adjust the Repeat delay slider 

9 To change the repeat rate, adjust the Repeat rate slider. 
9 Test your new setting. 
9 Tap “ OK” to exit the “Keyboard” Tab. 

 

 
 Figure 3-12 
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3.2.15 Mouse 
 
Table 3-14 Mouse(A) 
  ICON  ITEM & FUNCTION 

z “Double-Click” Tab :( Figure 3-13-1,Figure 3-13-2)   
Mouse 9 Double-click the checkerboard grid at comfortable speed 

9 Double-click the Test icon to test your setting. 
9 The function is OK if the figures are changed from Figure 

3-13-1 to Figure 3-13-2. 
9 To tap “OK” to exit the Mouse tab. 

 

   
      Figure 3-13-1                        Figure 3-13-2 
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3.2.16 Network and Dial-up Connections 
Table 3-15(A) Network and Dial-up Connections 
  ICON  ITEM & FUNCTION 

 
Network 
and Dial-up 
Connections 

z “Connection” Tab :  

 9 To create a “Dial-up Connection”: 

¾ Double-tap the “Make New connection”. 
¾ In the “Make New Connection” dialog box, enter a name for 

the connection. 
¾ Select “Dial-Up Connection”. 
¾ Select the “Next” button. 
¾ Select the modem you want use. 
¾ Select “Configure” 

¾ Under “Connection Reference”, use the default settings 
provided. If you can’t connect using these settings, see your 
ISP or network administrator for specific information. If you 
want to always enter a phone number before connecting, 
Select “Manual Dial”. Select “OK”. 

¾ Select “TCP/IP Settings”. In the “General” tab, ensure “Use 
Server-assigned IP address” is selected. In the “Name 
Servers” tab, ensure “Use Server-assigned addresses” is 
selected, and select “OK”. If you are unable to connect with 
these default settings, see your ISP or network administrator 
for specific TCP/IP information. 

¾ Select the “Next” button and type the telephone number. 
¾ Select the “Finish” button. 

The connection you just created appears as an icon in the “Network 
and Dial-up Connections” folder.   
 

9 Set up a point-to-Point Protocol(PPP) account with an ISP and 
obtain the following information: 

¾ Access telephone number 

¾ User name 

¾ Password 
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Table 3-15(A) Network and Dial-up Connections 
  ICON  ITEM & FUNCTION 

 
Network 
and Dial-up 
Connections 

Once you have established an account, create a new connection on 
your device. When creating this connection, you should be able to use 
all of the default TCP/IP settings provided in the Make New 
Connection Wizard. If you can’t connect using the default settings, 
contact your ISP or access your ISP’s Web site for specific TCP/IP 
information as well as primary and secondary DNS address. 
9 Modify connection setting 

¾ Select Start > Settings > Network and Dialup Connections 

¾ Select the icon for connection settings you want to modify. 
¾ Select File > Properties, or double- tap the appropriate icon. 
¾ Select desired options. There may be additional settings that 

depend on the connection. To modify, select the icon and 
select the icon and select Advanced Settings… from the 
menu. 
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3.2.17 Owner 
  
Table 3-16 Owner 
  ICON  ITEM & FUNCTION 

z “Identification” Tab : (Figure 3-15-1) 

9 Fill in or edit the data as desired. 
9 To have this information displayed when you start your device, 

select “Display Owner Identification” at Power On. 
9 To set up identification for remote networks, see Setting up 

identification for remote networks. 
z “Network ID” Tab: (Figure 3-15-2) 

 
Owner 

9 Enter the user name, password, and domain name you use to log 
on to remote network. 

 
 

          
Figure 3-15-1                         Figure 3-15-2 
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3.2.18 Password 
  
Table 3-17  Password 
  ICON  ITEM & FUNCTION 

z “Password Setting” Tab : (Figure 3-16)  
Password 9 Enter the password 

9 In the “Confirm password “box, enter the password again. 
9 To require the password on startup, select “Enable password 

protection at power- on“. and/or select “Enable password 
protection for screen saver” 

9 To exit the Password control panel, press “OK” from the 
control bar, or press the <Enter> key on the keypad. 

 

        
Figure 3-16 
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3.2.19 PC Connection 
  
Table 3-18  PC Connection 
  ICON  ITEM & FUNCTION 

z “PC Connection” Tab : (Figure 3-17-1)  
PC 
Connection 

9 Select the first checkbox to enable direct connections to the 
desktop computer. (Figure 3-17-1) 

9 Tap the “Change Connection…” button to modify the 
connection method from USB, IrDA, or Serial. (Figure 3-17-2) 

9 To exit the “Change Connection” dialog, press “OK” from the 
control bar, or press the <Enter> key on the keypad. 

9 To exit the “PC Connection” properties control panel, press 
“OK” from the control bar, or press the <Enter> key on the 
keypad. 

   
      Figure 3-17-1                         Figure 3-17-2 
 
 
 
 
 
 
 
 

P3-52 



3.2.20 Power 
Table 3-19  Power 
  ICON  ITEM & FUNCTION 

z “Battery” Tab : (Figure 3-18-1) 

9 Provide change level indicators for Main battery and Backup 
battery. 

9 To exit Battery control panel, press “OK” from the command 
bar, or press <Enter> key on keypad. 

 

z “ Schemes” Tab: (Figure 3-18-2) 

9 The Scheme Tab allows you to determine the time to switch 
state to Suspend mode when using either Battery Power or AC 
Power. 

9 Select Battery Power or AC Power as the power scheme from 
the pull-down list.( Figure 3-18-2) 

9 Select the time to suspend mode from the pull-down list. 
( Figure 3-18-3) 

z “Device Status” Tab: ( Figure 3-18-4) 

 
Power 

Provide power level of device – The power level ranges from 
“ High(D0)” which means the device is at the highest power level to 
“Off(D4)” which means the device is at the lowest power level. 

   
       Figure 3-18-1                      Figure 3-18-2 
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      Figure 3-18-3                     Figure 3-18-4 
 
3.2.21 Regional Settings 
Table 3-20  Regional Settings 
  ICON  ITEM & FUNCTION 

z “Region” Tab : (Figure 3-19-1)  
Regional 
Settings 

9 Select the desired location/language. 
9 Review the Appearance samples in the bottom half of the 

screen. 
9 Select the Tab at the top for any settings you wish to change, 

Options to modify include Number, Currency, Time, and Date.
( Figure 3-19-3 ~ Figure 3-19-9) 
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       Figure 3-19-1                      Figure 3-19-2 

   
Figure 3-19-3                      Figure 3-19-4 
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        Figure 3-19-5                      Figure 3-19-6 

   
         Figure 3-19-7                   Figure 3-19-8 
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 Figure 3-19-9 
 
3.2.22 Remove Programs 
Table 3-21  Remove Programs 
  ICON  ITEM & FUNCTION 

z “Remove Programs” Tab :   
Remove 
Programs 

9 Only user installed programs can be removed. 
¾ Select the program you wish to remove from the list and press 

“remove” button. 

 
3.2.23 Storage Manager 
Table 3-22  Storage Manager(A) 
  ICON  ITEM & FUNCTION 

z “Storage Manager” Tab : (Figure 3-20) 

 
Storage 
manager 

9 To change Storage properties control panel default settings: 

Insert. Compact Flash(CF) or Secure digital (SD) storage card into 
the unit. 
¾ Select Start > Settings > Control Panel > Storage Properties 
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Table 3-22  Storage Manager(B) 
  ICON  ITEM & FUNCTION 

z “Storage Manager” Tab : (Figure 3-20) 

 
Storage 
manager 

¾ From the “Storage Info” pull-down list, select the desired 
storage device. 

¾ You can also format, dismount, and create partitions on storage 
devices using this control panel. 

¾ To save and exit the Storage Properties control panel, press 
“OK” from the control bar, or press the <Enter> key on the 
keypad. 
Caution: Dismounting or formatting the DiskOnChip will 
erase all files and program stored in Flash Memory 

 

   
          Figure 3-20 
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3.2.24 Stylus 
Table 3-23  Stylus(A) 
  ICON  ITEM & FUNCTION 

z “Double-Tap” Tab : (Figure 3-21-1,Figure 3-21-2) 

9 Double-tap the checkerboard grip at a comfortable speed. 
9 Double-tap clapboard to test your settings 

9 The function is OK if the figures are changed from Figure 
3-21-1 to Figure 3-21-2. 

9 To tap “OK” to exit the Stylus Properties. 
z “Calibration”: (Figure 3-21-3) 

 
Stylus 

9 In the Welcome Wizard, you tapped a target with the stylus to set 
the amount of pressure needed for the screen to respond to your 
stylus taps. 

9 Please also see 2.4.3: Calibration of the touch Screen  
 

   
          Figure 3-21-1                         Figure 3-21-2 
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      Figure 3-21-3                        
     
 
3.2.25 System 
Table 3-24  System(A) 
  ICON  ITEM & FUNCTION 

z “General” Tab : (Figure 3-22-1) 

9 To show: 

¾ Firmware information  

¾ Information about Processor type, Memory size, Expansion 
card 

z “Memory”: (Figure 3-22-2) 

 
System 

9 Move the slider to adjust memory allocation. Default storage 
memory is normally is normally set to about 8MB with the 
reminder assigned to Program memory. 

9 Press the “OK” key on the Keypad.  

Note: the difference is occupied by OS between the RAM size in 
Information properties and total memory size of storage memory 
and program memory  
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Table 3-24  System(B) 
  ICON  ITEM & FUNCTION 

z “Device Name” Tab : (Figure 3-22-3) 

9 Your device uses this information to identify itself to other 
computers. 

9 The input panel will open to facilitate data entry. 
9 To close the Device Name, press the “OK” button, or press the 

<Enter> key on keypad. 
z “Copyrights” Tab: (Figure3-22-4) 

 
System 

9 Refer to this tab for specific copyright data. As a user, you are 
responsible to read this statement. 

 
  

                         
Figure 3-22-1                        Figure 3-22-2 
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          Figure 3-22-3                   Figure 3-22-4 
 
3.2.26 Volume & Sounds Properties 
 
Table 3-25  Volume & Sound 
  ICON  ITEM & FUNCTION 

z “Volume” Tab : (Figure 3-23-1) 

9 The factory default for Volume is the forth level. You can adjust 
the volume to your environment and comfort.  

¾ Set the volume by adjusting the slider from Soft to Loud, 
or press Right or Left edge of Navigation keys 

z “Sounds ” Tab: (Figure3-23-2) 

 
Volume & 
Sound 

9 Enable the desired sounds for key clicks, screen taps, 
notifications, and applications. 

 
 
 
 
 
 
 
 
 

P3-62 



 

    
      Figure 3-23-1                        Figure 3-22-2 
 
 

3.3 Taskbar and Start Menu 
Table 3-26  Taskbar and Start menu 
  ICON  ITEM & FUNCTION 

z “General” Tab :  

9 In this tab, You can change the position of the Taskbar and Start 
menu  

¾ Is always on top or not 

¾ Auto hide or not 

¾ Show Clock or not 

z “Advanced ” Tab:  

 
Taskbar and 
Start Menu 

9 Tap the “Clear” button to remove the contents of the Documents 
Menu. 

9 Enable “□ Expand Control Panel＂ to list all icons of Control 

Panel from top to bottom. 
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Chapter 4 
Communication 

4.1 Installing & Setting Up Microsoft ActiveSync 

4.1.1 Installing Microsoft ActiveSync on the Host PC 
Microsoft ActiveSync is a file transfer tool to synchronize the files on a PC with the 
files on your PDA.  
 To install Microsoft ActiveSync, complete the following steps on the PC: 

1. Go to the Microsoft Windows CE.NET website and download the most current 
version of ActiveSync: 
http://www.microsoft.com/mobile/pockeypc/downloads/ . 

    
2. Install the most version of Microsoft ActiveSync on the host PC. 
3. Open ActiveSync. 
4. Select File > Communication Settings from AtiveSync’s menu bar. 
5. Go to “Using ActiveSync” on page X.X to continue using ActiveSync. 

 
4.1.2 Connecting PDA to Host PC 
1. You can use either the USB/Serial(RS232) port of Single Dock or a 

USB/Serial(RS232) cable to connect the PDA to the Host PC. 
z To use the dock, you must first insert the PDA into the slot, making sure that the 

unit is firmly seated the dock. 
z To use the cable, connect the USB/Serial cable to the PDA. 
 2. Connect the USB/Serial dock or cable to the Host PC’s serial port or USB port. 
 3. Connect the dock or PDA to the power adapter and power source.  

 
4.2 Using ActiveSync 
 
Use ActiveSync to transfer and synchronize files between the PDA and the Host PC. 
 
4.2.1 Setting up a Partnership 
 
During the Microsoft ActiveSync installation, you were prompted to create a  
 

P4-1 



 
partnership with your mobile device. When you set up a partnership, you select 
synchronization and file conversation settings, which are contained in a file on your 
desktop computer. This file enables your desktop computer to recognize your device. 
Only devices that have a partnership with a desktop computer can synchronize 
information between the two computers. 
For more information on partnerships, please refer to your Microsoft ActiveSync 
documentation or help file.  

 
 
9 Navigate to the target directory on your PDA and copy the desired file by using 

the Copy/paste method or dragging and dropping the desired file(s) into the 
folder. 

4.2.2 ActiveSync File Synchronization 
 ActiveSync files synchronization requires an ActiveSync partnership between the 
PDA and the Host PC. Refer to “Setting up a Partnership”, above: 

9 Select the files in the synchronization configuration for the PDA partnership. 
9 Select Tools > Options from the ActiveSync command bar to configure the 

synchronization options. 
9 Place the file to be synchronized in the Synchronization folder created you’re 

My Documents directory. Defaults to the desktop. During the ActiveSync 
connection, all files in the Synchronization folder will be synchronized to the 
\My Documents directory on the PDA.  
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Transferring Files: 
To transfer files, complete the 
following steps on the host PC: 
9 Select Start> Programs 

>Communication >(IrDA, 
Serial, or USB) Activesync. 

9 Double-click on the selected 
ActiveSync icon 

9 After you have established a 
connection with PDA, tap the 
“Explore” button at the top of 
the ActiveSync window ( or 
select Explore from the File 
menu).  



4.2 Networking 
    Please see the 3.2.17 Owner, Table 3-16 Owner on page 3-50 for setting up the 
network ID. And see the 2.5.6 Initiating a Network Connection to setup the 
802.11b Wireless LAN for RF connecting. 
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